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1. Introduction

1.1 Overview

This whitepaper outlines how to perform |live backups
database. If you need to backup individual mailboxes from an Exchange Server see our Exchange Mailbox
Add-on whitepaper located on our online education centre: http://www.backupassist.com/education

1.2 Requirements

To backup and restore your Exchange Server information store using BackupAssist you need the following:

e BackupAssist v4

¢ Windows 2000, XP or 2003 Server

¢ Microsoft Exchange Server 2000, 2003, 2007*
¢ Windows Backup (NTBackup)

The Windows Backup program includes facilities to perform live, online backups of an Exchange server.
This means that the Exchange Server does not have to be stopped to perform an Exchange backup.

BackupAssist uses this feature of Windows Backup, whilst also working around several bugs in Windows
Backup to deliver a reliable solution. Using BackupAssist you can select and backup local and remote
Exchange Server storage groups, which can then be used to restore an entire Exchange server, including
public folders.

*See section 1.3 below for Exchange 2007 specific requirements for remote server backups.

1.3 Exchange 2007 requirements (remote server backups only)

If you are attempting to backup a remote Exchange 2007 server you will need to install the Exchange Server
Management Tools on the machine where BackupAssist is installed:

1. If you have installed BackupAssist on a 32-bit operating system:

Download and install the Exchange Server 2007 Management Tools (32-bit):
http://www.microsoft.com/downloads/details.aspx?familyid=6BE38633-7248-4532-929B-
76E9C677E802&displaylang=en

2. If you have installed BackupAssist on a 64-bit operating system:

Install the Exchange Server 2007 Management Tools (64-bit) from the installation disc or download that
was used to install Exchange 2007 on your remote server.

In addition, if you have installed a version of Exchange Server 2007 that came pre-packaged with Exchange
2007 Service Pack 1, you will need to make a small alteration to the Windows registry due to a change made by
Microsoft.

Note: if you installed Service Pack 1 after installing Exchange Server 2007 the change should not be required.
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Excerpt from Microsoft article:

As part of the Microsoft continuing security initiatives, Microsoft Exchange Server 2007 Service Pack 1 (SP1)
introduces a behavior change designed to reduce the attack surface of the system. This change directly affects
remote streaming backups on Windows Server 2003.

To adhere to the Microsoft Secure by Default initiative, the remote streaming functionality disabled (server-wide)
in Exchange 2007 SP1 is disabled by default. A manual override in the form of the following registry value must
be enabled to restore this functionality:

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\MSExchangelS\ParametersSystem
Name: Enable Remote Streaming Backup

Type: DWORD

Value: 0 = default behavior (remote backup disabled); 1 = remote backup enabled

Refer to http://technet.microsoft.com/en-us/library/aa998870.aspx for full instructions.

Note: BackupAssist cannot be used on a Windows Server 2008 machine to backup a local Exchange Server
using NTBackup. This is because NTBackup is not present in Windows Server 2008. We recommend that you
run BackupAssist on a non-Windows Server 2008 machine and backup your Exchange Server remotely.

At the time of writing (May 2008), we are planning an addition to BackupAssist to backup the Exchange
Information Store on a Windows Server 2008 machine directly, in place of NTBackup. Please check our
website for further updates.
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2. Backing up an Exchange Server

2.1 Creating a backup job

Before you can select your Exchange Server for backup you will need to first create a backup job in
BackupAssist. If you already have a backup job configured for this purpose you should skip to section 2.2.

To create a backup job:

1. Launch BackupAssist and from the File menu select New backup job.

2. Select NTBackup and click Next.

Continue configuring your backup job according to your requirements. Exchange backup will be
configured once the job creation is complete.

4. If you do not need to select data in the Files and folders step click Next and then Ignore when prompted.

Once you have created your backup job you will be presented with the job edit window:

£ Backuphssist vd M[=] B3

File Edit Wiew  Sethings  Jobsettings  Quick actions  Help

@f Home ‘El Monitor . Reports t Events

Restore .ﬂ: Settings

|jOVEWiEW | Job summary

@

{3 Destination
The Fallawing is & surimary of the job configuration:
% Scheduling Destination: '-1_'.] Local direckory  wiew setkings
(1 Calendar Schedule: 0‘, Most recent full  view settings
LY Files and falders
¥ Job name and description 7]
™ Exchange Servers
950 # | Job status L7 ]
B VErS

Q,J Motifications -:) Job is currently active

S SCHpEs

Activate Active jobs will run according ko the schedule specified in the Scheduling Section
[ Open files
Suspended jobs can only be run manually From the Quick actions menu (left), or by
ﬁ MTBackup options using a Deskkop Shorbcut (also awailable in the Quick actions menu)

Quick actions > &pply changes

Cancel
L

Contack support!

Trial mode: 30 left in trial

We will now discuss how to add an Exchange Server to your backup job using the Exchange Servers Window.
There are two types of Exchange Server backup available:

Information store: entire Exchange server database

Individual mailbox: brick-level backup of user mailboxes (requires the Exchange Mailbox Add-on)

We will only be focusing on Exchange information store backup in this whitepaper. Refer to the Exchange
Mailbox Add-on white paper for details on how to backup individual mailboxes.
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2.2 Adding an Exchange Server to your backup selections
To add an Exchange Server backup to your job configuration:
1. From the left menu under Job settings select Exchange Servers.

2.  Within the Exchange Server selection section click Add Exchange Server. A window will appear that
displays all of the available Exchange Servers on the network.

£ Backupassist v4 =10

File  Edit  Wiew  Setbings  Job settings  Quick actions  Help

@ Home ‘El Monitor [ Reports ‘ Events [® Restore g#f Settings

Job settings Job - Exchange selections

A Cverview % Exchanne Server calaction 7]

Backupassist

<5) Destination

o 52l Exchange server addition
Scheduling o
Autodetecting available Exchange servers @ Backu pAbSISt bdd Exchange Server...
ﬁ?] Calendar
i *} Fles and folders ¥ Mal Thege Exchange servers are available for backup: @
_ L CORTEX-CAZ4XIBS
¥ Mai &

| % Exchange Servers

J 50L Servers
“;) Motifications
4 Scripts
[ open Files
3 NTBackup options

To add the available servers to vour backup click Add,

add | [ Cancel

Quick actions » Apply changes LCancel

% Contact support! Trial mode: 30 :ft in trial

Note: Exchange Servers residing on a different domain to that of the machine where BackupAssist is
installed will not be detected and cannot be backed up.

3. Click Add to add all of the available Exchange servers to your backup selections.
4. Check Backup storage groups for each Exchange Server you want to backup.
5.  Now select which storage groups to backup for each Exchange Server:

0 Check Select all storage groups if you wish to backup all storage groups and any future storage
groups that are created (recommended). You can exclude specific storage groups if required by
unchecking them, but all future storage groups created will still be backed up.

o Or, leave Select all storage groups unchecked and individually check each storage group to
backup. No storage groups created in the future will be backed up, only those selected.

6. Click Apply changes when you have finished making your selections.
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2.3 Performing a backup of your Exchange Server

To test your Exchange Server backup you can either run your backup job manually or wait for the next scheduled

backup to occur.

BackupAssist backs up your Exchange Server during the second phase of the backup process, after the selected
data files and system state (both optional) have been backed up. This helps to eliminate an issue with Windows

Backup where a backup of both the system state and Exchange Server information store in the same pass fails.

To run a backup of your Exchange Server manually:

1. Click Quick actions from the top menu of BackupAssist and select Run now.

2. Choose Run a future backup and click Run.

During the backup processyouc a n

BackupAssist - Monitor

Recent jobs monitor

Yiew running, of recently completed jobs

(O Job (3/1942008 4:49:36 PM)
& Selections Check
& Checking destination
@ Preparing Far file backup
% Phase One Backup
(2 Phase Two Backup (lNINHEN

Carnpile media usage report

50.0%

Vv

i ew

Drivve:

Skatus:

Progress:

Processing:

Files:
Bybes:

ME/Sec:

the |j oMénstormindogr ess in the

7]

|CORTEX—C."-\24><IBS'|,Micr050Ft Information Store'\Fir

|Backing up files From wour computer,,.

Processed
3
5,415,914
4.21

=Y Refresh Report

Notice that it is during Phase Two that the information store of your Exchange Server is backed up.
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2.4 Examining your backup logs

Once the backup completes, to ensure that your Exchange Server was backed up correctly you should examine
the backup report:

1. Click Reports in main navigation bar of BackupAssist.
2. Double-click the latest report in the list of a job that includes Exchange.

3. Scroll down to the specific section in the report for Exchange Server backup:

& Job - Wednesday, March 19, 2008 [_ (O] xi

2~

A Exchange Server _:_j

“CORTEX-CA24XIB8\Microsoft Information Store'First Storage Group" Selections - 8.02MB Backup @ Verify @

Backup of "CORTEX-CAZ4XIBS\Microsoft Information Store\First Storage Group"
Backup set #Z on media #1

Backup description: "Set created 3/19/2008 at 4:54 PM"

Media name: "Z008-03-18.bkf created 3/13/2008 at 4:45 PM"

Backup Type: Normal

Backup started on 3/19/2008 at 4:54 PM.
Backup completed on 3/19/Z008 at 4:54 PM.
Directories: 3

Files: 3

Bytes: 8,413,914

Time: 3 seconds

Verify of "CORTEX-CAZ4XIBS\Microsoft Information Store\First Storage Group"
Backup set $Z on media #1

Backup description: "Set created 3/19/Z008 at 4:54 PM"

Verify started on 3/19/2008 at 4:54 PM.

Verify completed on 3/19/Z008 at 4:54 PM.

Directories: 3

Files: 0O

Different: O

Bytes: 8,413,914

Time: 1 second

“CORTEX-CA24XIB8\Microsoft Information Store'Second Storage Group" Selections - 24MB Backup @ Verify @

Backup of "CORTEX-CAZ4XIBS8\Microsoft Information Store)\Second Storage Group"
Backup set $3 on media #1

Backup description: "Set created 3/12/Z008 at 4:54 PM"

Media name: "Z008-03-18.bkf created 3/19/2Z008 at 4:45 PM"

Backup Type: Normal

Backup started on 3/13/2008 at 4:54 PM.
Backup completed on 3/19/2008 at 4:54 PM.
Directories: 3

Files: 3

Bytes: 25,191,162

Time: 6 seconds

Verify of "CORTEX-CAZ4XIB8\Microsoft Information Store\Second Storage Group" e
Backup set $3 on media #1

Backup description: "Set created 3/19/2Z008 at 4:54 PM"
Verify started on 3/19/2008 at 4:54 PM.

Verify completed on 3/13/Z008 at 4:54 PM.

Directories: 3

Files: 0O

Different: 0

Bytes: 25,191,162

Time: 1 second

In this example, two different storage groups were backed up. The report will indicate that status of the
backup and verify of each storage group selected. Successful backup and verification is denoted by a green

tick & and unsuccessful backup and verify with a red cross 0.
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In the following example three steps are carried out to perform the Exchange Server restoration. This example
follows from the backup process completed during section 2. This example assumes that the system is

functioning properly and that Exchange Server is installed on the system.

3.1 Dismounting Exchange Server stores

Before you can restore your Exchange Server database you will first need to dismount the stores you are
restoring to:

1.

2.

4.

Launch the Exchange System Manager from the Start menu.

Expand the Servers tree to locate the appropriate server and storage group (screenshot below).

Right-click each store listed individually (typically Mailbox Store and Public Folder Store) and select

Dismount Store:

*. Exchange System Manager

@ File Action View Window Help

e B BRXTRE |2

@ First Organization (Exchange)

Mailbox Store (SUGARS)

+]-_1 Global Settings ame

Recipients

[JLogons
Servers

[ Maiboxes

~{_1 Mailboxes
{1 Full-Text Indexing
=125 Public Folder Store {(SUs
21 Logons
-3 Public Folder Instar

Stark Full Population
Pause Population
Stop Population

A Full-Text Indexing

Create Full-Text I@x

Start Incremental Population

‘i) Public Folders

: Al Tasks
e | Replication Status

0 Full-Text Indexing  Yiew
[#-{_ Protocols

News Window from Here

¥ Connectors
¥ Tools
¥]-{_ Folders

Cut

Copy

Delete
Rename
Refresh
Export List...

|pismounts this store

Properties

Help

Your stores should have an icon with a red arrow to indicate that they have been dismounted:

1 Global Sertings

{3 Recipients

[=-{_3 Servers

E-3 SUGARS

!E Queues

: J First Storage Group
[El-i%) Mailbox Store {SUGARS)

. {3 Logons

-+ 4 Mailboxes

i 4 Full-Text Indexing

52 Public Folder Store (SUGARS)

~{_4 Logons

{4 Public Folder Instances

~{_4 Public Folders

+-{_4 Replication Status

i 4 Full-Text Indexing

.

Name

d¥iMailbox Store (SUGARS)
@ Public Folder Store (SUGARS)
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3.2 Using Windows Backup to perform the restoration

Run Windows Backup (NTBackup) to restore your Exchange Server database:

1. Goto Start Menu > All Programs > Accessories > System Tools > Backup
2. If Windows Backup launches in Wizard Mode click the Advanced Mode link
Backup or Restore Wizard |
Welcome to the Backup or
Restore Wizard
Thiz wizard helps you back up or restore the files and
zettings on your computer.
I wou prefer, you can switch jo tolchange the
zettings used for backup or 1 ammended
for advanced users only.
To continue, click Nest.
< Back I Mext » I Cancel |
3. [Optional T remote restore]: If you are restoring to a remote Exchange Server click the Backup tab and
then select Tools > Remote store from the top menu and enter the name of your remote Exchange Server.
4. Now click the Restore and manage media tab.
5. Locate the backup file or tape you wish to restore from and expand this tree until you locate the Exchange
Server Information Store.
6. Select each storage group you wish to restore:

[ Mailbox Store (SLIGARS)
B2 Public Folder Store (SUGARS)
[+ [ )= Fram Madia

[ eutone files to | -files alreacy exist:

Do not mplace

Drginallocahan

|

B Backup Utility - [Restore and Manage Media] = =10 x|
(lob Edit View Tools Help
Welcome | Backup Restors and Manage Media | Schedule Jobs |
Exparid the desitad media tem. then chsck the bog (or the ieme Lo estors. Right chick on g media lem (or options.
# [ )& dmm DDS Narie | Size | Madified |
(= [} & File [ 1) Log Filles 312720031223 PM
(=[] [g) BAbks created 3/12/2003 at 12:21 PM [ 13 Mailbox Stare (5U... AM2/200312:23 PM
Dl‘ iC [ 122 Public Folder Stor... 3/12/200312:23 PM
B2 A - LI GARS \Miciozolt Information Store\Fist Storage Group
B2 Log Files

Start Flestore
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7. Click Start Restore. You will be prompted with several choices:

Restoring Database Store - 21|

You have selected to restore backups from a database store.

This backup data may be restored ta the original server, of Cancel |
re-directed to another database server.

Backup From: SUGARSAMicrosoft Information StorebFirst Storage Group

Restore To:

ISUGAHS Browse... l

Temporary location for log and patch files:
I cihtemp

IV Last Restore Set [Log file replay will start after this restore completes.]
Iv' fiount Distabase After Hestorg

o In this example we are restoring to a local Exchange Server so the Restore To field has been
filled with the computer name of the local machine.

o The Temporary location for log and patch files should be any directory with enough free space
to perform the restore and Windows Backup will create the directory if it does not already exist.

o If you are restoring a full backup of Exchange ensure that the last two options are checked. If you
are restoring an incremental or differential backup, you should refer to the section 4 for additional
resources.

8. Click OK to begin the restore of your Exchange Server.

3.3 Checking the restore logs

Once the restore is complete, you should see the following window:

Restoreprooress TR

The restore is complete.

To see detailed information, click Report. _ﬂ]

Drive: ISUGAHS\Microsoﬂ Information Store’First Stora
Label: |BA.bks created 3/12/2003 at 12:21 PM
Status: |Completed
Elapsed:
Time: I 3 sec.
Processed:

Files: l B
Bytes: I 21,013,392

Click Report to view the logs The backup log will show the results of the Exchange Server restore operation:

P backup10.log - Notepad .IJEJE
File Edit  Format  View Help
rRestore Status JE |

Operation: Restore

packup of "sucars\microsoft tnformation Store\First Storage Group', Restored to'sucars\microsoft rnform
Backup set #2 on media #1
Backup description: "set created 3/12/2003 at 12:23 pm"

Restore started on 3/12/2003 at 12:31 PM.
Restore completed on 3/12/2003 at 12:31 PM.
pDirectories: 4

Files: &

Bytes: 21,013,392

Time: 4 seconds
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